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Abstract

Systems containing high heat generation require thermal management, especially in a solid
oxide fuel cell gas turbine (SOFC/GT) hybrid system [1]. The startup of each system in a
standalone configuration may be a trivial approach, but when coupled together, different dynamics
are experienced. The SOFC/GT provide high theoretical efficiency due to the ability to recover the
extra heat produced by the fuel cell (FC) to drive the gas turbine (GT). After recovering the energy
recuperated in the GT, the exhaust gas heats the cathode inlet flow to the FC which is an advantage
during nominal operation of the cycle but not during startup. During startup of the SOFC/GT
system, the turbine needs to startup as fast as possible where the surge is avoided and slow enough
that the high heat of exhaust gas does not thermally shock the FC.

Therefore, with a bypass valve integrated in this system it will help to control the air flow
going towards the FC and GT. Although a high temperature valve can be custom design by any
company, it can result very expensive. However, self-designing the valve has also led to many
challenges by examining the properties of materials that can stand very high temperatures. Other
challenges are the design of the valve built-in to the actual SOFC/GT hybrid system, testing in
high temperatures, analyzing the composites’ displacement, tolerance at different voltage levels,

and identifying how much flow rate will flow through the pipe or get blocked.
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Chapter 1

INTRODUCTION AND BACKGROUND

This study proposes a high temperature, and pressure bypass valve to control the airflow
going towards a turbine and heat exchanger during the startup of a SOFC/GT system [1,2]. To
control the high temperatures exhausted from the post-combustor, a bypass valve will be placed
before the heat exchanger to regulate the airflow going to the fuel cell and avoid thermal stress on
the material. However, during startup, the turbine also needs to achieve a nominal speed of 40,500
rpm and once it is achieved the valve must stay partly open to keep a certain amount of heat flowing
through to keep the system operating. The main objective of this project is to design and develop
a bypass valve capable of withstanding high temperatures, and pressure airflow during the startup
of a cyber-physical SOFC/GT hybrid system located in the U.S. Department of Energy’s National

Energy Technology Laboratory (NETL) in Morgantown, WV.

1.1 DESIGN BACKGROUND

High-temperature valves are hard to find in the market due to its high complexity of having
a design that can withstand very high temperature ranges. Many companies or laboratories can
have a custom design but can result costly. Hence, NETL’s goal is to open new development ideas
in this research area since it could become very efficient for a hybrid system. New development
ideas for this research helps scientists to investigate a variety of valves to widen their knowledge
for new applications and at the same time it saves them money. Many valves used in piping were
studied to find different types of designs held out in the market [3].

The attain of this research was to determine which valve is useful for the design to be

modernized. An innovation for the valve was to integrate a composite inside the pipe acting as a



valve working as a gate. In order to perform this task, the design of the valve was first considered
to visualize how the composite was going to be positioned inside the pipe. Finally, the gate valve

was chosen to be the initiative of the design.

1.2 HIGH TEMPERATURE VALVES IN THE MARKET

There were six different types of valves found in the market designed for high
temperatures. These companies were not found in the United States of America, but only in Italy
and Germany. Shown below is a table listing the valves found along with their design parameters

and other information.

Table 1.1: Different Types of Valves in the Market

Type of Valve Company Temperature Range Material
Floating Ball Erreesse 551°C to 1100°C Specific metal alloys
Trunnion Ball Erreesse 551°C to 1100°C Specific metal alloys
Rectangular Jasta -100°C to +1100°C Steel/Stainless steel
Weld-in EDR 1 Jasta -100°C to +1100°C Steel/Stainless steel
Weld-in EDR 11 Jasta -100°C to +1100°C Steel/Stainless steel
Weld-in EDR 111 Jasta -100°C to +1100°C Steel/Stainless steel

These valves are used for extreme temperature range, so specific alloys are studied for high
temperature conditions for an appropriate valve construction. Custom designs are offered for the
individuals need depending on the application of the actuator. Drying and dust extractors, gas
turbines, heat treatment, cement factories and high temperature furnace construction are some
application areas these valves are used for. However, these valves need to be operated manually
which is why this project proposes a different type of valve. A goal of this project is to protect the

individual operating the valve due to high temperature exposure.



1.3 DOE HYPER FACILITY

Figure 1.3.1 illustrates the system concept of a hybrid FC/GT cycle that combines heat and
hybrid power system. The anode, electrolyte and cathode block represent the SOFC stack in which
methane is reformed and becomes oxidized for power generation. The reformer residuals flow into
a post-combustor for additional power generation. However, the use of a pre-combustor in front
of a fuel cell may cause H,0 going into cathode, which would accelerate the degradation of the
fuel cells. Thus, an additional heat exchanger is proposed to warm up the cathode airflow, in which
a bypass pipe with valve is needed for startup. Figure 1.3.1 circled in yellow shows the location of

the heat exchanger and bypass pipe proposed for this project.
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Figure 1.3.1: Hybrid Performance (HYPER) Project Diagram



The bypass valve controls the airflow directed to the turbine and the fuel cell. The bypass
valve is represented in figure 1.3.2 illustrating the position of the piezoelectric. When the
piezoelectric is subjected to voltage it will bend; the piezoelectric remains in a flat position when
no voltage is used. The application of the piezoelectric material in the bypass valve is explained

further ahead.

Piezoelectri

Figure 1.3.2: Bypass valve representation for HYPER facility

1.4 HIGH TEMPERATURE MATERIALS

The most significant task is to explore on the material of the valve, especially looking into
a flexible composite. It is important to consider the curie and melting temperature of each
composite. If the temperature of the valve exceeds the material’s curie temperature, then this
composite would lose all its electromagnetic properties and would not function correctly. Many
composite materials were analyzed, however, the shape memory alloy (SMA) offered the best
mechanical properties for the valve. The three studied SMA are the following: nickel titanium (Ni-
Ti), nickel titanium cobalt (Ni-Ti-Co) and nickel titanium copper (Ni-Ti-Cu) [4].

Most of the materials considered for this project are smart materials. The next sections
discuss more in depth what types of materials were considered and explains what their functions

are. However, SMA and MFC were the most intriguing materials to work with and analyze. The



material for the actuator used inside the pipe is the most important job to be determined in the
design. The selection of the material will help accomplish the mechanism of the valve acting in a
hybrid system at extremely high temperatures. This chapter gives a brief explanation on what types
of materials were sought and how they have been applied in research areas and in the industry.

The next materials discussed are in the same order as this research was being constructed.

1.5 LITHIUM NIOBATE THEORY AND APPLICATIONS

Lithium niobate is a high temperature piezoelectric with a curie temperature of 1050°C and
a melting point of 1250°C [11]. It can be used for a variety of applications like sensors, mobile
phones, optical and some others. Lithium niobate was discovered by Matthias and Remeika in
1949 to speed the need on technologies for data storage, biomedical and defense applications in
the industry [12]. This piezoelectric offer great mechanical properties that meet the design
requirements in high temperatures, but it is not flexible enough to be used as an actuator. Table
1.2 display different types of piezoelectrics along with its curie temperature, thus assuring lithium

niobate can tolerate high temperatures [12-16].

Table 1.2 Types of Piezoelectric

Material Transition Transition Type
Temperature, °C

Bismuth Titanate, 670 Curie Temperature
Bi;Ti0g

Lithium Niobate, 1210 Curie Temperature
LiNbO4

Lithium Tantalate, 634 Curie Temperature
LiTa0;

Lead Titanate, 450 Curie Temperature
PbTiO,

Lead Zirconate Titanate, 350 Curie Temperature

PZT




Nowadays Lithium Niobate is mostly used for photonic crystal applications which are
optical materials to control light flow. These types of applications also include lasers, non-linear
optics, optical communications, optical memories, and diffractive optics [21].

Yongfa Kong et al wrote about the recent progress in lithium niobate [33]. Studies show
that lithium niobate along with magnesium have been considered the material with best optical
damage resistance. However, recent results designate that lithium niobate and zirconium have a
much higher optical damage resistance in visible region, and in the ultraviolet. Lithium niobate is
considered one of the most important synthetic crystals. Yang He et al studied the lithium niobate
microring resonators [34], in which engineering of group-velocity dispersion (GVD) is crucial for
most important nonlinear photonic applications. Throughout many research studies it is approved
that lithium niobate shows great material properties with prodigious potential for countless

applications.

1.6 MACRO FIBER COMPOSITE THEORY AND APPLICATIONS

A Macro Fiber Composite (MFC) is a smart material that was invented by NASA’s
Langley Research Center in 1999 which is still being developed for aerospace structures at NASA
[5]. It is a low-cost piezoelectric device that reduces vibrations, deflections in composite beams,
and noise. Some interesting benefits this smart material offers are flexibility, durability,
lightweight, sensing and among others. An important benefit that the MFC operates is that it can
elongate (d33 effect actuator) and contract (d31 effect actuator) [7]. The MFC is built of ceramic
fibers and can be attached to a substrate to have a greater curvature as shown in figure 1.6.1

working like a monomorph actuator.



Figure 1.6.1: MFC joined to a carbon steel sheet

The Smart Material company’s article Development of an MFC Bending Element as an
Actuator for Sensor Systems describes three different bending actuator designs [6]. Figure 1.6.2
shows how the monomorph, bimorph and trimorph designs work as an elongation and contraction
actuator. The monomorph consists of a substrate attached to the MFC inducing a curve by
elongating. In order to perceive a greater deflection, two MFC’s should be attached to each other
acting as a bimorph actuator. A bimorph will generate a greater expansion between the layers since
piezo material on the top expands at the same time piezo material on the bottom contracts. A
trimorph involves the addition of a substrate between two piezo materials, however, it reduces the

deflection of the actuator but increases the bending motion.

| Bending Actuators 1
|
| | |
Monomorphs I Bimorphs I I Trimorphs I
Actuator ﬁctueto_r Actuator
elongating Pie 20 Material elongating Biezo Material ] elongating Piezo Material ]
Substrate
1 e
Substrate Actustor Piezo Material 2 ) / Piezo Material 2
ctuator

contracting contracting

Figure 1.6.2: Design Variants for Piezoelectric retrieved from Smart Material GmbH article

The MFC directed to be a great asset to function as a valve actuator because of its

mechanism. However, in order to apply motion to the piezo material a certain voltage must be



applied. The MFC P1 type (d33 effect actuator) operates between -500V to +1500V in order to
actuate with a maximum operating temperature of 130°C. This piezo material was not going to
accomplish the design requirements of operating in high temperatures from 1000°C to 1200°C, but
its properties were still analyzed. To achieve a greater deflection, the material attached to the macro
fiber composite can be steel, aluminum or carbon fiber with a thickness of 0.1 to 0.3 mm.

Most MFCs have been applied in aerospace, civil structures, automotive industry and many
others. Most of these applications contain energy harvesting in many different variations that can
positively impact the community. MFCs can provide strain actuation, vibration control, and
sensing elements. Eduardo Padoin et al studied how to use an MFC to reduce induced structural
vibration [36]. The project proposed in this article assured it was possible to improve the behavior
of a controlled structure increasing the MFC capability to control the structural vibrations.

Xiao Sun et al designed an MFC for wind turbine blades on fatigue load reduction. This
article [37] provides the design and simulation of an MFC to determine a fatigue analysis on a
serrated microflap that can reduce the standard deviations of the blade root flapwise bending

moment.

1.7 SHAPE MEMORY ALLOY THEORY AND APPLICATIONS

Shape memory alloys (SMA) were discovered by Chang and Read between the 1950s and
1960s [8]. There are many metal alloys, but due to nitinol’s properties it is the shape memory alloy
that is most commonly known and used. There are various types of shape memory alloys that can
be found, such as wire, sheet/plate, and springs. SMAs are smart metals that react to low and high

temperatures. An SMA can be deformed at low temperatures from its original profile and will



return to its original shape when exposed to heat. These smart metals experience two phases called
martensite and austenite in which occurs at two different temperature ranges [9].

According to the Shape Memory Polymers: Properties, Synthesis and Applications article,
it states that these phases cause a symmetry change in the crystalline network. As the metal alloy
reaches a low temperature and cools down, the martensite phase starts forming by concluding at
very low temperatures. The austenite phase starts when heated, so it starts to restructure until it
reaches a certain temperature in which the phase has been finished. Figure 1.7.1 visually explains
how the metal alloy undergoes these phases.

Phase 1

e e e e e e
. @ e (& e (@
Cooling/ @—0—@—0—@—*_ *— . = s

*
/ © wﬂing

®—e—@®—o—@®—o
@@ o —@

® e @ e (o —
-~ ——® o9 Deformation

®—e—@® o @ o

Phase 2 Phase 3

Figure 1.7.1: Shape memory effect retrieved from Shape Memory Polymers: properties,
synthesis and applications article

As mentioned before, SMAs are known and commonly used due to its interesting
mechanical properties. Nitinol’s melting temperature is up to 1310°C, therefore, it can withstand
very high temperatures. Using a shape memory nitinol alloy spring as shown in figure 1.7.2 can
fulfill the design requirements by being exposed in high temperatures and correctly function as an

actuator.

Lk

Figure 1.7.2: Nitinol Memory Metal Spring SMA retrieved from Fuxus site



There are many applications of SMAs in aerospace, automobile, civil structures and several
others in the industry. SMAs are used in applications for braces and dental arch wires, fixing
broken bones using metal plates, bridge structures to dampen vibrations, aircraft and space vehicles
because they are lighter and save energy. Hugo Rodrigue et al discuss in their article [38] how
SMA wires and springs are implemented as actuators in robots. A model is then developed to
discuss the performance and applicability of SMA wires versus SMA spring to be used as
actuators. Other articles explain how SMA are used for seismic loads, such as Hui Qian et al
investigated a building structure with a super elastic shape memory alloy. The investigations from
this article [39] used shaking table tests by experimenting on new super elastic shape memory
alloy friction damper. The damper consisted of pre-tensioned super elastic shape memory alloy
wires and friction devices. The main function of SMA wires in this research was to provide re-

centering capacity, while the integrated friction devices provide the most energy dissipation.

1.8 THESIS OBJECTIVE

The objective of this thesis is to design a high temperature bypass valve for a hybrid system.
This will ensure to control the flow exiting from the post-combustor to avoid damaging the fuel
cell by blocking the flow and leading it to the turbine. The tasks needed to complete the objective
for this thesis are as follow:

Task 1: Design a 3-inch diameter pipe with an expected temperature inlet of 1100°C to

1200°C.

Task 2: Investigate and select a composite material to withstand high temperatures.

Task 3: Provide calculations and design blueprints to build prototype.

Task 4: Perform CFD simulations to compare with calculations and experimental work.
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Task 5: Describe and explain the design process to complete final design.

1.9 PRACTICAL RELEVANCE

The motivation for this project is to design an affordable high temperature bypass valve for
a hybrid system. A custom design can be created for any individual searching for a high
temperature valve, but it can result expensive. Creating an affordable composite material design
would benefit NETL to be used multiple times for any type of experiments. By integrating this
valve into the HYPER facility, it would not only limit NETL to perform various experiments, but
also would give the opportunity of adding an actual fuel cell to the system. Fuel cells are expensive
and can be damaged easily when they are under thermal stress. This valve would help blocking
flow exiting from the post-combustor and leading it to the gas turbine. Researchers can control
this valve from the control room, not having to control the valve manually and being exposed to

high temperatures.
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Chapter 2
CALCULATION THEORY
This chapter explains some theory behind the calculations for an MFC and SMA. The
calculations shown below can guide the individual to build the prototype. It is important to
understand that most of the equations provided in this chapter can be applied when starting to
design an SMA spring. However, in chapter 4 three equations provided here helped determine how

much force can a spring with specified dimensions provide.

2.1 SHAPE MEMORY ALLOY CALCULATION THEORY

As explained in chapter 1, these smart metals experience two phases called martensite and
austenite. The shape memory element has four temperatures that describe the different stages of
actuation. Figure 2.1.1 outlines the four temperatures transformation from start to end for austenite
and martensite phases. These temperatures and acronyms are as follows: Martensite (1) Finish

[Mf], (2) Martensite Start [Ms], (3) Austenite Start [As], and (4) Austenite Finish [Af].

r_""_,,r"'

Length Change (Stroke)

&

L 4

Mf s As Af
Temperature

Figure 2.1.1: SMA Length vs Temperature retrieved from Large Force Shape Memory Alloy
Linear Actuator by Jose R. Santiago Anadon
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The shape memory alloy spring offer a great amount of length when force is applied.
Waram’s [22-24] calculation for shape memory spring procedures are summarized below.
Calculations for compression and extension spring are explained further down. Figure 2.1.2 shows
a schematic of geometric properties of a spring actuator [29]. The SMA spring design has three
geometrical parameters to contemplate:

e Wire diameter
e Average spring diameter

e Number of coils

Mean Diameter

—_—
Wire — T
Diameter
Free
Length
Pitch
Coil Angle

Figure 2.1.2: Spring actuator schematic retrieved from NASA’s Engineering Design Tools for
Shape Memory Alloy Actuators: CASMART Collaborative Best Practices and Case
Studies

2.1.1 Compressed Spring Calculations

When a compressed shape memory alloy spring is put under low temperature, the spring
compresses and extends when heated as shown in figure 2.1.3. In figure 2.1.3 shown at top is the
extended spring described as high temperature length (L;) and below is the compressed spring

described as low temperature length (L;); length change is defined as stroke (S).
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High Temperature Length (Lp)

a1

Low Temperature:

Low Temperature Length (L;)

Figure 2.1.3: Example of compression spring reacting to temperature

Two equations are combined to simplify the expression for shear stress in a spring. The
first equation in terms of shear stress in a SMA spring was expressed by Liang and Rogers [25]
shown below:

T =10 = GO —vo) + = (T = To) + 2 (€ — &) (1)

In which 1, G, vy, ©, &, T, and Q are shear stress, shear modulus, shear strain, coefficient of
thermal expansion, martensite volume fraction, temperature and phase transformation coefficient.
The subscript ‘0’ represents the initial conditions. Assuming shear strain is linear in the spring
wire cross section, the spring coil diameter is continuous through the spring length. According to
Shigley from Mechanical Engineering Design textbook [26], shear strain can be related to axial
spring deflection through the next expression shown below where dg, Dg and N are the SMA spring

wire diameter, mean diameter of the spring, and the number of spring coils:

y =25 )

- 2
nND3
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The expression for shear stress in a spring is finally defined by Aguiar, Liang and Rogers
and Shigley [27] as:

_ 8FD

R%E

= - CK [MPa] 3)

Where F defines the axial load applied, D is the average diameter of the spring, d represents

the wire diameter, K is the correction factor applied, and C is known as the spring index as follows:

C== [m] “

The K value in equation (5), also known as Wahl correction factor, is the torsional stress
for a solid round bar. This value corrects the shear stress for transverse and torsional shear stresses

present in a spring shown below:

4C-1 | 0.615
Kv =2t )
Equation (5) is most recommended for fatigue loading [28] while equation (6) is regularly

used for static loading:

Ko= 1+ (6)

Equation (3) can be used to obtain several wire diameters for acceptable values for the
actuator of C between 3 to 12. From equations (3-6) only apply to normal geometry springs which
is C>3 and A<12°. It is also important to note that the maximum shear stress depends on the type
of alloy used. An estimated value for 100,000 cycles for Nitinol (Ni-Ti) is 170 MPa. Equation (7)
shown below is how to obtain the wire diameters for the actuator:

8FCK
T

[m] (7
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Two factors relate to the value of C which are the cycle rate and the envelope volume for
the actuator. The cycle rate is a function of the wire diameter, so a value of C can be designated to
put up a desired cycle rate. The other method to set the value of C subject to the envelope volume
of the actuator which depends on the spring outer diameter and length. The equations discussed
next are values that typically come from the company’s datasheets. However, the reader will
comprehend how to obtain these values to apply to the equations discussed before and after.
Equation (8) explains how the average diameter can be obtained from equation (4) by solving for
D:

D=cd [m] (8)

The inner and outer diameters can also be obtained from equations (9) and (10). The
number of turns in the spring is obtained from equation (11). The value of S defines the stroke of

the actuator, and the Ay is the strain difference at high and low temperatures shown in equation

(12):
OD=D+d [m] )
ID=D-d [m] (10)
n=—2_-_3 (11)

B nD2Ay ~ mwDCAy

Ay =y — Yn (12)

The high temperature shear strain can be obtained from a stress-strain material chart for

the assumed high temperature shear stress. Another method is estimating this value assuming a
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linear stress-strain behavior, so that the high temperature shear strain can be evaluated from the
high temperature stress (75 ) and shear modulus (Gj,) explained below in equation (13). The spring

rate for the high and low temperature ranges can also be estimated as shown in equation (14) and

(15):
Vi =g (13)
Gpd* Gpd
h = g.p3 (14)

" 8nD3  8ncC3

_ Gid* _ G
" gnD3 ~ 8nc3

(15)

l

Once gathering the spring rate, the high temperature deflection can be evaluated through
equation (16):
F

6 = o [m] (16)

To define the low temperature deflection, it is known the stroke is the difference between
the low and high temperature spring deflections, so equation (17) can be used to find that value.
Equation (18) describes the length of the spring when compressed at low temperatures. At high
temperature the spring length is solved through equation (19), and the free length of the spring is
defined at equation (20).

Li=dn+3) [m] (18)
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Ly=L+S [m] (19)

Ly =Ly + 6y [m] (20)
Since this project proposes a one-way shape memory spring, through equation (21) the
required force to revert the shape memory alloy to its original shape can be solved. Equation (22)

can calculate the maximum force that can be exerted by the spring:

E = k5, [N] (21)
trd*
= onD3 [N] (22)

To evaluate the envelope volume of the spring it can be defined below in equation (23).
The envelope volume helps to evaluate the best value for the spring index; however, as discussed

before the student can use any of the two different methods.

Ao =2 [m?] 23)

2.1.2 Extension Spring Calculations
An SMA extension spring extends at low temperatures and contracts when heated by

providing a pulling force. Figure 2.1.4 shows the SMA extension spring actuation below.

High Temperature Length (Lj)

High Temperature:

an




<
<

»
>

Low Temperature Length (L;)

Figure 2.1.4: SMA spring extension reacting to temperature

The equations discussed in section 2.1.1 can be used to calculate the number of turns, spring
rates, spring diameters, and to reset the spring shape. However, the spring lengths are different
from the compressed spring to the extended spring because the extended spring is reversed from
the compression lengths so they must be reassessed. Equation (24) evaluates the spring body length
in a fully compressed spring where n is the number of turns of the spring. The length at which the
spring shape setting takes place can be defined as a function of the body length in equation (25).
When the spring is under high temperatures the length can be obtained from equation (26). Finally,

equation (27) is used to calculate the low temperature length.

L,=dn+1) [m] (24)
Ly =L, +2(ID) [m] (25)
Ly =Ls + 68, [m] (26)
Li=L,+S [m] (27)

2.1.3 Shape Memory Alloy Activation
Shape memory alloys can be heated and activated by passing direct current through them
or heating them up. Their length and cross-sectional area can be used to calculate the resistance

shown in equation (28). In which p represents the SMA resistivity, A its cross-sectional area, and
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L is the free length of the alloy. Through Ohm’s Law the voltage required can be calculated from

equation (29), and the power requirement on equation (30).

L
R=5 [Q] (28)
vV =IR [V] (29)
W =1V = IR [W] (30)

Waram explains a detailed method in his textbook to estimate the current value and cooling
times for the actuator [30]. He derived those formulas by testing a specific type of alloy under
motionless and forced air conditions. The thermo-mechanical properties of shape memory alloys
differ critically from alloy to alloy, so it is mostly recommended to define the activation current

through testing.

2.2 MACRO FIBER COMPOSITE CALCULATION THEORY

A piezo actuator has two features which are the idle stroke and the blocking force. The
blocking force is the maximum force generated by the actuator. This force is defined when the
displacement of the actuator is entirely blocked, so it works against a load with an infinitely high
stiffness. In order to estimate the stiffness, the blocking force is measured when the actuator is
displaced and then reverted to the initial position with an external force (blocking force). The idle
stroke is a small gap between the piezoelectric actuator and the wall of the pipe.

Equation (31) is used to calculate the required deflection from the cantilever where
u, L and Ry are defined as free deflection, actuator length and curvature of the structure. In order

to solve for Rk, equations (32-35) were combined assuming the curvature of the actuator, the strain
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from figure 2.2.1 [6], the longitudinal forces defined by N, so equation(35) defines the curvature

of the structure combined with all equations mentioned:

1 12
u =—:=:x—
Rk 2
Rax ? Ri. ~ Rx ‘\__Q/'

Aktive Schicht:
Aur Lix, Eax aux

Laminat:
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b

- »

N
4»“)"*%%%%

________ Sy, )M SN

€2))

Figure 2.2.1: Bending actuator schematic retrieved from Development of an MFC Bending
Element as an Actuator for Sensor Systems
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Now equation (37) can be used to find the force needed to push the cantilever tip shown

below:

(37)
Equation (38) estimates the dynamic behavior of the piezoelectric, where

QAaccel Mstructurer Fpiock T€Present acceleration, mass structure and block force.

Fblock = Mstructure * Aaccel. (38)

Most of the equations discussed in this chapter were obtained from Development of an
MFC Bending Element as an Actuator for Sensor Systems, so in order to compare results it would

be best to test the actuator and compare calculations with a force vs displacement graph.
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Chapter 3

DESIGN MODEL

This chapter explains how the design of the valve has been changing as most materials
have been analyzed. The final design will briefly explain the movement of the actuator and how
this will achieve the design requirements. It also includes a list of supplies to build a testing

prototype of the valve and a final prototype to integrate it in the hybrid system.

3.1 DESIGN CONSTRAINTS

Many aspects of any design project must be considered to determine the feasibility of a
product. The success of a project depends mainly on the scope, time, budget, and quality.
Sustainability and manufacturability go under quality referring to the ability of designing a product
to perform under normal operating conditions for a given amount of time. While choosing an
actuator that was reliable, the budget also had to be considered. Both the MFC and SMA offered
great abilities for the valve, however, the MFC was more expensive. SMA are cost-effective and
their mechanical properties met the standards for the project.

Time is accountable when testing, in which the MFC took most of the project’s schedule
while confirming its functionality. Ordering materials, building prototypes, investigating more
about the project, and testing the prototype are important tasks to work alongside a schedule.
Budget is an important factor when developing a high-quality project. Selecting parts, making
modifications, manufacturing lifetime product were considered by choosing the broadest parts to
ensure a durable artifact. The focus in this project is to design a high-performance valve to

accomplish most proposals from laboratories.
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3.2 BOUNDARY CONDITIONS

Air is considered in the computational model discussed in chapter 4, and at the lab during
testing. The flow rate delivered for a lab prototype and final product for the HYPER facility is
different. The prototype should deliver flow near to 0-5 g/s through the pipe, in which a mass flow
meter will verify this value. As for the actual final product it must deliver near to 50-100 g/s, and
this could be verified by sending the final design to the HYPER facility to test it. The lab prototype
temperature inlet must be 100°C with the help of a heater or heat exchanger. The boundary

conditions detailed in tables 3.1 and 3.2 were used to design and to be tested in the prototype.

Table 3.1: Lab Prototype Boundary Conditions
Inlet Boundary Conditions

Mass Flow Rate 0-5 g/s
Temperature 100°C
Actuator Electric Activation 6-12V
Pipe Material (Wall) PVC
Table 3.2: Final Product Boundary Conditions
Mass Flow Rate 50-100 g/s
Temperature 1100-1200 °C
Actuator Electric Activation 6-12V
Pipe Material (Wall) Steel

3.3 APPROACHING THE DESIGN
As explained earlier the first important task was designing the valve. This was
accomplished by using the Bernoulli equation and calculating the pressure drop, friction factor,
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length of the pipe, internal diameter of the pipe, average velocity, fluid density and the gravitational
constant. Many assumptions were considered to accomplish the goal of the design, which helped
to shape the path of the design. After visualizing the idea of the design, the second important task
was finding the material for the actuator.

As stated above, the Bernoulli equation along with other equations shown below were used
to calculate many values. Starting a design is difficult at first because is hard to know where to
start. Many assumptions were made while brainstorming for a design, but also applying equations
from fluid mechanics to estimate outcomes. Shown below is a one of the starting process for this
project. The dimensions used for these calculations were of a 3-inch pipe diameter assuming steel
roughness. The purpose was to get an idea of the velocity this valve was going to confront, but at
the end for sure the velocity was too high. Another important task was calculating the pressure

drop for an elbow and a sweep tee design.

kg
41h 4(0.19)
e =0 — — =31,379.2 TURBULENT (39)
mDu m(0.0779 m)(520.9x1077 —
+10-5
Friction Factor = = = 22T = 578+ 10 = ~0.045 (40)
4(3.93%101 m3)
v 9310717 m
@ = 757 = nGra i = 8265 1)
LV? v?
h, = hL,maj + hL,min = fsg + Zkz (42)
(s32)°
0.254m 5)
hymaj = (0.046) (0.078 =) « o 52.6 (43)
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m 2
V2 83?
himin = 2k 3= = (578 m)( (5%)

o) = 2028.08 (44)
h, = 52.66 + 2028.08 = 2080.7 (42)
AP = (2.54+10722) (9.815) (2080.7) = 5183 Pa = 0.05 bar (45)

High temperature materials were studied on their mechanical properties by investigating
how flexible they can operate. In this design, the actuator, the hinges, and the plate are the special
features that were integrated to accomplish the goal of the project. The following sections

thoroughly articulate how the valve must work under assigned boundary conditions.

3.4 PRELIMINARY DESIGNS

Various designs were proposed for the high temperature valve by adding piezoelectric
actuators. Brainstorming was important to put designs together and understand how the valve can
deliver a great work performance. The goal of design #1 on figure 3.2.1 was to puncture holes
around the pipe and use piezoelectrics resting inside over each hole to block the flow from exiting
the pipe. However, whenever voltage was subjected to the piezoelectric, it would cause the actuator
to vibrate and the flow would escape. At last the design was not the best option to use for the

project.

1 Piezoelectric

Figure 3.2.1: Design #1
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Design #2 proposed to use rectangular piezoelectrics inside the pipe, so that when voltage
was applied to each actuator it would make it bend upward by preventing flow to pass through the
pipe. There were many factors to contemplate for this design by having a turbulent flow or high

pressure drop.

Figure 3.2.2: Design #2

A Y-shape pipe was proposed for design #3 alike #4 by directing controlled flow to the
fuel cell and turbine. The pipe would have a circle wall inside punctured with holes and each of
the holes having an actuator on top. This design offered the same goal as design #1 but having

“more controlled” flow.

Piezoelectric

Figure 3.2.3: Design #3
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Figure 3.2.4: Design #4

In the end these designs were not chosen because of high pressure losses, difficult to
manufacture, and most of the ideas lead to failure while trying to implement the movement of the

actuator.

3.5 VALVE DESIGN

After investigating the material for the valve, two designs were proposed to utilize three
different actuators. The first design shown in figure 3.5.1 has a sweep tee shape in an angle of 45°.
Design #1 was planned to use the lithium niobate piezoelectric or the MFC for the actuator in case
one or the other failed. This design utilizes a 3-inch diameter pipe with an expected temperature
inlet of 1100°C - 1200°C, and a 4-bar pressure with an expected valve mass flow rate of 50 — 100
g/s. This specific shape along with the angle was selected to have a controlled smooth flow passing

through the pipe to avoid pressure drop. The design requirements are listed more in detail below

in table 3.3.

Table 3.3 Valve Design Requirements
Design Requirements

Dimensional Length Scale (in) 3”
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Temperature Inlet (°C) 1100 - 1200

Pressure (bar) 4

Valve Mass Flow Rate Expected (g/s) 50-100

This bypass pipe has a special feature, which is a square pipe shape located at the center
approximately 6-inches long. The purpose as to why this shape was utilized in the design is because
the MFC and the Lithium Niobate piezoelectric working as an actuator inside the pipe is a
rectangular shape. Leading the fluid from a circular shape to a rectangular shape of the pipe serves
as a great advantage in the design to at least expect a uniform flow passing through the pipe. Many
articles have studied the behavior of a square cylinder [19] which has interesting topic of
discussion, analyzing corners of the square that can deliver many different behavioral data when
exposed to an airflow. Otherwise, if complications arise with the airflow, then a honeycomb
airflow straightener can also be used in the setup.

After the square shape, the pipe will return to its standard circular shape. The distance from
the square shape to the circular shape is highly important to have a smooth airflow. Figure 3.5.1
shows two piezo plates fixed at one end from the wall of the pipes. These two piezo plates will be
attached from a custom piezoelectric mount design, which will have two small holes on the top to
connect two cables to a power supply and control the motion of the piezoelectric.

These piezoelectrics are applied a specific voltage at a fixed end to cause a movement to
partly open and let the airflow pass through. When no voltage is supplied to the piezoelectric, it
will block the airflow by remaining closed. Whenever the voltage is applied to the piezoelectric,
it should bend up or down, working as a gate by opening and closing. Piezoelectrics are utilized

everywhere and can function as an actuator or a sensor, but in this case, it is being used as an
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actuator. As stated before, the piezoelectric or MFC are the actuators acting as a valve, thus

working as a gate in design #1.

Piezoelectric

Figure 3.5.1: Design #1 for MFC and lithium niobate piezoelectric

Design #1 discussed before seemed achievable, but to have a more efficient assembly it
was better to work with design #2. Figure 3.5.2 shows design #2 with SMA springs and nitinol
plates put together. The design will contain a total of six SMA springs, in which the nitinol plate
will have the six SMA springs attached. The plate along with the springs are attached from a hinge
and the hinge will be glued to the pipe. In order to accomplish the work of the gate, a hinge is very

flexible to move the actuator up and down.

Circular Pipe Shape

4

Square Pipe Shape

4
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Figure 3.5.2: Design #2 using SMA spring and nitinol plate

The use of a custom piezo mount design in design #1 was mentioned, but this mount was
not going to help achieve a complete bending motion to the MFC and piezoelectric. If the actuators
do not have a bending support, then the results would be catastrophic because the actuators would
not last long and could break. This is the reasoning of why a hinge is convenient to use. The hinge
will be manufactured out of silicon carbide material. Silicon carbide is listed in the top ten metals
to withstand very high temperatures with a melting point of 2820°C [17].

Table 3.4 Design #2 Materials

A | 1/2” Spring (3 total)

B | 1" Spring (3 total)

C | Nitinol Plate

D | Hinge

Figure 3.5.3: Design #2
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The reason as to why a total of six springs must be used is because one SMA spring

provides up to 4 Newtons (N) (408 g) of force upon contraction or expansion. The nitinol plate is
going to have three %—inch spring at the bottom (A) and three 1-inch spring at the top (B) to help

expand and block the air flow as shown in figure 3.5.3. When the nitinol plate is exposed to heat,
it will always maintain a straight form to avoid any bending. The six springs are going to be
insulated in order to control the motion whenever the researcher decides to open the actuator since
the heat of the air flow inside the pipe will keep spring expanding.

To conclude, design #2 will be built using one plate with six 0.3-inches long wires shaped
in semicircle and soldered to the plate. This way the springs are going to grasp from the plate and
the pipe will have six holes to insert one end of the springs. The wire at the end of each spring will
be taken out through the six holes to control its motion by applying current with a power supply.
The plate is going to be attached on the hinge and the hinge from the pipe with the use of ceramic

adhesive that can resist over 2000°C, or through welding [18].

Table 3.5 shows a list of materials needed to build the final design of the valve:

Table 3.5 List of materials for final design

Description Quantity
1 SCH 40 Pipe 1
2 SMA Spring 6
3 SMA Plate 8’ x 12’ 1
4 Silicon Carbide Plate 8’ x 12’ 1
5 SMA Wire (connects plates to 1
spring) 1-ft
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6 Soldering Iron 1

7 Power Supply (control SMA springs) 1

8 Ceramic Adhesive (2000°C) 1

3.6 FUTURE WORK SETUP

A prototype is going to be built and tested to gather data on how much deflection the SMA
spring attached to the plate will experience when in motion. Figure 3.6.1 demonstrates the
prototype setup to test the actuator’s performance under pressure, heat and voltage. In order to
validate the function of the actuator, two SMA springs attached to a nitinol plate are planned to be
used to be tested due to its great mechanical properties of deflection and resistance in high
temperatures.

The prototype design is different from the actual in order to mainly focus in the behavior
of the airflow and the deflection of the springs. A list of materials is listed below shown in table
3.6. An air source is going to be connected through item D and the flow meter in item A will read
the flow rate passing through. Item C is shown in figure 3.6.2 of how the actuator is going to be
fixed inside the PVC pipe with a close-up showing how the plate and springs are attached as shown
below.

Table 3.6: List of Materials for Test Prototype

A | Flow Meter

B | 22 PVC Pipe
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C | Actuator Mount

D | Air Source Connector

E | Valve

F | Power Supply

G | Soldering Iron

H | SMA Spring (2)

I | Nitinol Plate

Figure 3.6.1: Valve prototype design

Applying different voltage inputs to the SMA spring using a power source will help find a
relationship between the flow rate going through the pipe. The actuator is planned to be exposed
to different temperatures at the same time voltage is supplied to analyze its behavior under these
conditions. The power supply will flow current to the top of the wires to control the actuator’s

mechanism. In order to test the prototype, there will be a flow source (fan or gas cylinder)
connected to the end of the Zg-inch pipe and deliver near 0 to 5 g/s through the pipe and valve. At

different points of the pipe, the flow rate passing through the pipe is going to be measured using a
mass flowmeter. The goal of this experiment is to achieve a mass flow rate of 5 g/s. This prototype

will mainly help validate the function of the actuator’s deflection.
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Figure 3.6.2: Actuator inside of prototype

3.7 SAFETY ANALYSIS

During the design phase it is important that each component integrated is subject to a safety
analysis. Shown below are flow diagrams that mention precautions from the design and afterwards
an explanation of safety measures.

Table 3.7 Safety analysis

5 Tools and 2

-g . Training = Training

o Equipment @

]

S <

Q Installation B PPE o Test Plans and
IS @ Procedures
> ()] c

o e © -

L Planned Testin © Emergency T Installation
o 8 v Actions o Procedures
c £

20 . Safety Storage o Instrumentation
0 Maintenance ’ ] .

8 Equipment 8. Diagram

A design documentation must be provided to all team members to understand the project
and tasks that must be delivered. The design documentation must contain tools and equipment
used while building the prototype of the design and the final design integrated to the system. It
should also include installation describing where each part is located correctly to avoid any

tragedies before it is operated. Any type of testing should be discussed and analyzed before to
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understand what data is needed and how it should be operated. Maintenance should always be
provided to any type of machine to avoid any errors while testing or electrical failures.

For any type of operations there should be safety measures provided for the operators.
Before any operation there should be training provided for the workers to understand safety
precautions. Safety equipment storage should also be checked regularly to have everything in
stock. All safety equipment should be provided to the operator and the operator is responsible to
wear it. One type of training is the Personal Protective Equipment (PPE) that explains the type of
equipment that protects the operator against health or safety risks at the lab.

PPE is important because it provides instructions, procedures and training that encourage
the person to work safely. The following are some types of PPE provided by the Health and Safety
Executive that can be used [20]:

Table 3.8 Types of PPE

Eyes Head Ears Hands Feet
*Goggles eSafety eEarplugs *Gloves eSafety boots
eFace Screens Helmets eEarmuffs eShoes with
eFace Shields eHairnets protective
eVisors toecaps

While operating any type of machine, training must be provided to understand how to run
the machine properly. All test plans and procedures should be revised earlier with the supervisor
to check any errors and confirm to run the experiment. An instrumentation diagram should also be
provided to every team member to know where all parts are in the machine. The instrumentation
diagram will help the person to study the machine correctly and understand how it operates
properly.

Safety analysis is highly important in any work area to avoid accidents. All safety

measures should be responsibly taken with seriousness to achieve the task correctly and safely.
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However, if no safety measures are provided to a team member then approach the supervisor to

receive them immediately.
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Chapter 4
RESULTS AND DISCUSSION
This chapter clarifies how ANSYS was used to perform simulations on the final design. It
explains how the design reacts under laminar flow. Through the analysis of these simulations, it
assures the efficiency of the design to build a prototype and compare results. A prototype and a
test procedure are planned once the design of the valve is concluded. Spring calculations included

in this chapter explaining how much force each spring provides and the drag force of the air flow.

4.1 SPRING DESIGN CALCULATION

The valve was designed with six extension springs, where the spring extends when heated
as mentioned before. Using equations from chapter 2 can calculate the force one spring can
provide. The force sometimes has a major or minimal change depending on the wire diameter,
outer diameter, and the number of coils as explained in chapter 2. The wire diameter and spring
diameter from the spring in the design are 0.75 mm (wire diameter) and 6.5 mm to 9 mm (spring

diameters). Three equations from chapter 2 are shown below along with the calculation of the

force.
D 6.5 mm 0.0065m
C=-= = =8.67m 4)
d 0.75mm 0.00075m
4xC—1 0.615
K, = —=1.17 5
W 4xC-4 + c ®)
8*F 8*F

T = * (C+*K)—» 170 MPa = * (8.67m*1.17) =4 N (3)

Txd? 1x(0.00075 m)?2
For many applications the maximum safe stress for the wire is 170 MPa, so this shear stress

was considered in these calculations. One spring with the specified dimensions delivers 4 N, so
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the spring consisting at least 20 coils can be stable. The number of coils help the force exerted by
the spring to stay in firm position. This is the reason why six springs are part of the valve design
to accomplish the goal of the actuator. Table 4.1 gives estimates as to how much current and force
to expect from a Flexinol® actuator spring. Once calculating the force of the spring, this table was

reasonable to use to calculate the current and voltage needed to activate the actuator.

Table 4.1: Guidelines for actuator spring
Spring Wire Diameter (mm)

Resistance (ohms/meter)

Heating Pull Force (g)

retrieved from Flexinol®

Approximate Current (A)

3.45 4.33 243 34
2.54 8.27 139 1.9
1.37 29.13 39 0.7

Now using the Ohm’s Law, the voltage required for activation can be calculated as follows:
V=IxR (29)
However, typically these actuators require voltage around 6-12 V. Table 4.1 can be used

for assumptions, but it is also important to test the actuator with safety precautions.

4.2 LAMINAR FLOW ANALYSIS ON TEST PROTOTYPE DESIGN
An analytical solution was conducted to find the drag force of the flow passing through the
pipe as shown below:

F (46)

D:%pUZCdA
2
Fp=5+(12822)  (302) + (1.15) * (0.036 m?) = 24 N

Table 4.2: Drag force equation variables

Definition

Fp Drag force generated by the body (N)
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P | Density of the fluid (-2)

U Speed of the body or the fluid (?)

Cp Experimentally determined drag force coefficient

A Surface area of the body perpendicular to the flow (m?)

According to this result it is expected the drag force of the flow against the plate to be 24
N. As stated previously in section 4.1, one spring provides 4 N of force thus six springs were added
to the design providing 24 N of force.

The CFD from the test prototype was used to analyze the flow to compare the drag force
with analytical results. The velocity inlet input in figure 4.2.2 was 30 m/s in order to compare the
results to the analytical solution. It is understandable minor leakage will exist, but the plate will
block as much flow as possible. A medium mesh size was held for this CFD because the fine mesh
size was failing for results. The drag force determined with the CFD on figure 4.2.4 and 4.2.5

method was of 24 N similar to the calculations discussed previously.

Figure 4.2.1: Outside of pipe in ANSYS
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Outlet

Figure 4.2.2: Fluid streamlines inside the pipe

(d)

Figure 4.2.3: (a) Isometric View (b) Front View (c) Back View (d) Side View

..

Figure 4.2.4: 2D Valve Mesh Design
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pipe wall -24.186148

Figure 4.2.5: 2D Valve Design Velocity Vector and Drag Force Result

The following tables 4.3 and 4.4 explain the procedures along with boundary conditions

that were used for the CFD.

Table 4.3: Ansis Model Boundai Conditions for Laminar Flow

Dimensions Diameter: 2.5 inches
Geometry Long: 6 inches
Sizing > Turn off Proximity and Curvature Uniform or Adaptive
Mesh Create Named Selections Inlet (1)
Outlet (2)
Pipe (Body)
Fluid (Air)
Options > Double Precision
Setup
Processing Options > Serial
Models > Viscous Laminar
Materials > Fluid and Solid Air and Aluminum
Cell Zone Conditions > Fluid and Pipe Air and Aluminum (Verify)
Boundary Conditions > Zone > Inlet > Velocity Magnitude 30 m/s
' Monitors > Residuals > Continuity, x-velocity, y-velocity, z- | 1e-7 (accuracy)
Solution velocity
Solution Initialization > Initialization Methods > Standard | All zones > Initialize
Initialization > Compute from
Run Calculation > Number of Iterations 1000 (Maximum Iterations
for accuracy) > Calculate
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Velocity Vector > Domains > Fluid > Locations Fluid
Analyze velocity vector, contour, velocity streamlines™

Table 4.4: Ansis Model Boundai Conditions to Find Drai Coefficient and Drai Force

Results

Dimensions Diameter: 2.5 inches
Geometry Long: 6 inches
Sizing > Turn off Proximity and Curvature Uniform or Adaptive
Mesh Create Named Selections Inlet (1)
Outlet (2)
Pipe (Body)
Fluid (Air)
Options > Double Precision
Setup Viscous > k-epsilon
Materials > Fluid and Solid Air and Aluminum
Cell Zone Conditions > Fluid and Solid Air and Aluminum
Boundary Conditions > Inlet > Velocity Magnitude, Mass Flow | 30 m/s, 0.05 kg/s
Rate

Boundary Conditions > wall-plate > Wall Motion > Stationary
Wall > Shear Condition > No Slip > Toughness Models >
Standard

‘ Report Definitions > New > Drag Coefficient > Force Vector >
Solution 0,0,1 > wall-plate

Report Definitions > New > Lift > Force Vector > 0,1,0 > wall-
plate

Report Definitions > New > Force > Force Vector > After
computing drag force can be solved in any vector

Monitors > Residual > Continuity, x-velocity, y-velocity, z- | le-7
velocity

Initialization > Hybrid Initialization > Initialize

Run Calculation > Maximum Iterations > 1000 > Calculate

Go back to Report Definitions and compute for Drag
Results Coefficient and Drag Force

4.3 LAMINAR FLOW ANALYSIS ON VALVE DESIGN
A final analysis was made to the Y-shape pipe design to analyze the reaction of the air flow

inside. The velocity applied to this simulation was of 30 m/s in order to compare and verify with
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the results on section 4.3. The drag force can also be obtained with equation 46 by using different

velocities and changing the area as shown below.

Table 4.5: Y-Shape Model Boundary Conditions

Velocity 30 m/s

Dimensions Diameter: 3 inches
Long: 6 inches

(d)

Figure 4.3.1: Mesh for Y-shape Model (a) Isometric View (b) Front View (c) Back View (d)
Side View

Fp =12+ (1.28 %) x (30?)2 % (1.15) * (0.0456 m?) = 30 N
Procedures shown in tables 4.3 and 4.4 were also performed to analyze the Y-shape model,
but with different dimensions and other boundary conditions stated in the chart. The drag force
expected analytically for the Y-shape model is of 30 N assuring the design only needs the addition
of two more springs to achieve blockage with a total of 8 springs. The drag force also determined

from the CFD method was of 24 N. The reason for the big difference can be found in the size of

44



the generated mesh and the number of iterations. Computational results must be compared with

experimental results to understand the dynamics of the design better.

The recorded data was put together in a graph to compare the calculated drag force and the
drag force from ANSYS Fluent. Figure 4.3.2 shows the change of drag force as a function of

velocity attaining manual and CFD calculation results.

DRAG VS VELOCITY
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Figure 4.3.2: Drag Force vs Velocity Graph

Through the analysis and results from chapter 4, it provides the researcher with many
assumptions and ideas on how to start building the design provided or improving it and creating a
new one. The expectation of this research project is to start developing new ideas for high
temperature valve usage, especially under the environment of this research project working with a

SOFC/GT hybrid system.
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CONCLUSION

Chapter 5

This study proposes a high temperature and pressure bypass valve to control the airflow

going towards a turbine and heat exchanger during the startup of a SOFC/GT system. To control

the high temperatures exhausted from the post-combustor, a bypass valve will be placed before the

heat exchanger to regulate the airflow going to the fuel cell and avoid thermal stress on the

material. The following are key points this study determined:

1.

An SMA spring provides 4 N of force, whereas an MFC generates about 4kN/cm?
of force for the active cross section of the MFC.

Two different setups are to be developed. One of the setups is a room temperature
setup that can withstand 100°C, and the other is a high temperature setup for 1200°C
temperature range.

The mass flow rate expected for the room temperature setup is 5 g/s and the
expected flow rate for the high temperature setup is of 50-100 g/s.

A CFD model was developed to calculate the drag force reacting at a specified
velocity. The design model from this study operates at air flow velocity of 30 m/s
with a drag force of 24 N.

This prototype was designed to operate with both MFC and SMA; however, the

SMA spring proved to be more efficient as a slow-moving product when actuated.

The importance of this project is to lead new development ideas for high temperature

valves. Innovation increases the probabilities to react to changes and discover new opportunities.

This project leads to new ideas that can be implemented to many different SOFC/GT hybrid system

experiments, each of them serving a different project goal and helping achieve it.
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5.1 RECOMMENDATIONS AND FUTURE WORK

It is recommended that the MFC and SMA must be tested further ahead along with the built
prototype. The final product will be tested at elevated temperatures (up to 1200°C), which is the
similar temperature to experience at the Hyper Facility. Experimental verification must be
developed to prove the reliability of the product. How the MFC can be used as a sensor instead of
an actuator in the prototype must be analyzed as well. The design can be changed or improved in

order to deliver a stronger valve mechanism for the hybrid system.
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Appendix

Nomenclature

Symbol Definition
T Shear Stress
F Force
C Spring Index
K Wahl Correction Factor
d Wire diameter
D Average Diameter of the Spring
S Stroke, Displacement
OD Outer Diameter
ID Inner Diameter
n Number of Turns
14 Strain
Ay Strain Difference
) Spring Deflection
G Shear Modulus
R Resistance
I Current
Power
Voltage
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Re
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Reynolds Number
Viscosity
Mass Flow Rate

Newtons
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PIEZO MOUNT FOR LAB PROTOTYPE

£ 4

SHAPE MEMORY ALLOY INFORMATION

Type of Spring Brand Name Part Number/Ean UNSPSC Code
1-Way SMA Fuxus 3300058-5 (Part 31160000
Number)
2-Way SMA Nexmetal 0647732872286 -
(Ean)
1-Way SMA Kellogg’s Research | NITI-SPR-CTL-100- 31161900
Labs ST (Part Number)
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MACRO FIBER COMPOSITE INFORMATION

Brand Name Model Name

Smart Material Corporation M-2814-P1
Smart Material Corporation M-4005-P1
Smart Material Corporation M-2807-P1
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